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Resume

@ Overview to MATLAB environment
@ Overview of MATLAB programming and arrays
@ Solving linear systems in MATLAB

(]

Large sparse matrices and performance comparison
o Arrays

o Mathematical functions

@ You have been working at the posted exercises in small groups



Today

@ Graphics: basic and advanced plotting
@ Random numbers generation

o Writing your own functions (and small programs)
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Graphics

Random Number Generators

Introduction Fanctions

Plot measured data (points) or functions (lines)
Two-dimensional plots or xy plots

‘ help graph2d J

Three-dimensional plots or xyz plots or
surface plots

Lhelp graph3d J




Graphics

Random Number Generators

Nomenclature xy plot Fanctions
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Random Number Generators

Functions
An Example: y = sin(x)
The sine function
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The autoscaling feature in MATLAB selects tick-mark spacing.



Graphics

Saving Figures

The plot appears in the Figure window. You can include it in your
documents:

1. type
print -dpng foo
at the command line. This command sends the current plot directly to
foo.png

~~> help print
2. from the File menu, select Save As, write the name and select file format

from Files of Types (eg, png, jpg, etc)
fig format is MATLAB format, which allows to edit

3. from the File menu, select Export Setup to control size and other
parameters

4. on Windows, copy on clipboard and paste. From Edit menu, Copy
Figure and Copy Options
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Graphics

The grid and axis Commands

@ grid command to display gridlines at the tick marks corresponding to
the tick labels.
grid on to add gridlines;
grid off to stop plotting gridlines;
grid to toggle

@ axis command to override the MATLAB selections for the axis limits.
axis([xmin xmax ymin ymax]) sets the scaling for the x- and y-axes
to the minimum and maximum values indicated. Note: no separating
commas
axis square, axis equal, axis auto
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plot complex numbers

| y=0.1+0.9i, plot(y) \
| z=0.1+0.9i, n=0:0.01:10,
| plot(z."n), xlabels(’Real’), ylabel(’Imaginary’)

function plot command

| fplot (£, [1 21) \

[ £=0(x) (cos(tan(x))-tan(sin(x))); \ ‘ i
‘ [x,yl=fplot (function,limits) ‘ ”

plotting polynomials
Eg, f(z) = 923 — 52 + 3z + 7 for
—2<x<5h:

|a=109,-5,3,71; \
| x = -2:0.01:5; |
| plot(x,polyval(a,x)),xlabel(’x’),ylabel (*£(x)’)

. % 8 8 5 & §
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Random Number Generators

SU prOtS Functions

subplot command to obtain several smaller subplots in the same figure.

subplot (m,n,p) divides the Figure window into an array of rectangular
panes with m rows and n columns and sets the pointer after the pth pane.

e N
| x = 0:0.01:5; \
| 'y = exp(-1.2%x) .*sin(10%x+5) ; \
| subplot(1,2,1) \
| plot(x,y),axis([0 5 -1 1]) ‘
| x = -6:0.01:6; \
|y = abs(x."3-100); \
‘ subplot(1,2,2) ‘
| plot(x,y),axis([-6 6 0 350]) |
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Random Number Generators

Data Markers and Line Types Functions

Three components can be specified in the string specifiers along with the
plotting command. They are:
o Line style

o Marker symbol

e Color

plot(x,y,u,v,’--?) % where the symbols '——" represent a dashed line \

plot(x,y,’*’,x,y,%:°) % plot y versus x with asterisks connected with a dotted line \
plot(x,y,’g*’,x,y,’r--’) % green asterisks connected with a red dashed line ‘

% Generate some data using the besselj
x = 0:0.2:10; e
yO = besselj(0,x); .
y1 = besselj(1,x);
y2 = besselj(2,x);
y3 = besselj(3,x);
y4 = besselj(4,x);
y5 = besselj(5,x);
besselj(6,x);

o
(o)
I

plot(x, yO0, ’r+’, x, y1, ’go’, x, y2, ’bx’,
x, y3, ’cx’,
x, y4, ’ms’, x, y5, ’yd’, x, y6, ’kv’);
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[doc LineSpec ]

= Solid line - Plus sign
(default) = Circle r Red

= Dashed line et Asterisk =

et Dotted line e Point

- Dash-dot line = Cross ° s
'square’ or's' Square o Cyan
'diamond'or'd’ | Diamond o Magenta
- Upward-pointing triangle
v Downward-pointing triangle ] VAR
> Right-pointing triangle k Black
< Left-pointing triangle w White
‘pentagram or'p' | Five-pointed star

(pentagram)

" Cor'n' " Six-pointed star
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Random Number Generators

Labeling Curves and Data Functions

The legend command automatically obtains the line type used for each data
set

- N
| x = 0:0.01:2; \ 4 ‘ ‘ ‘
|y = sinh(x); \ — sinh(x)
| z = tanh(x); ‘ ~—-tanh(x)
| plot(x,y,x,2z,’--") ,xlabel(*x) \ 350
| ylabel (’Hyperbolic Sine and Tangent’) |
| legend (*sinh(x)’, tanh(x)’) J
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The hold Command and Text Annotations:-

| x=-1:0.01:1 \
| y1=3+exp(-x) .*sin(6*x) ; \
| y2=4+exp(-x) .*cos (6*x) ; \
| p1ot((0.1+0.91).7(0:0.01:10)), hold, plot(yl,y2) \
| gtext (’y2 versus y1’) % places in a point specified by the mouse \
‘ gtext (?Img(z) versus Real(x)’,’FontName’,’Times’,’Fontsize’,18) ‘

7 ' v v ' '

’Position’, [0,6],...
’FontSize’,16)

5 (3+¢" sin(62),4+ ¢ cos(6z)) \\\\ g
y2 versus y1 N\ ‘
° S 3 1 \ text (’Interpreter’,’latex’,... ‘
. o ) ] | ’String’,... ‘
I | 2$B+e~{-xF\sin({\it 6x}),4+e"{-xF\cos({\ |
¢ AN S \ it 6x}))$’, ... ‘
' \ \
\ |

( - Search Text Properties in Help
. : I Search Mathematical symbols, Greek
Letter and TeX Characters
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Axes Transformations Fanetions

10
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x x

Instead of plot, plot with

‘ loglog(x,y) % both scales logarithmic. ‘
| semilogx(x,y) % z scale logarithmic and the y scale rectilinear. \
‘ semilogy(x,y) % y scale logarithmic and the x scale rectilinear. ‘
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Logarithmic Plots

Remember:

1.

You cannot plot negative numbers on a log scale: the logarithm of a
negative number is not defined as a real number.

. You cannot plot the number 0 on a log scale: log;, 0 = —oc.

. The tick-mark labels on a log scale are the actual values being plotted;

they are not the logarithms of the numbers. Eg, the range of x values in
the plot before is from 10~' = 0.1 to 10% = 100.

. Gridlines and tick marks within a decade are unevenly spaced. If 8

gridlines or tick marks occur within the decade, they correspond to
values equal to 2,3.4, ..., 8,9 times the value represented by the first

gridline or tick mark of the decade.

Equal distances on a log scale correspond to multiplication by the same
constant (as opposed to addition of the same constant on a rectilinear
scale).

19
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log=" log="'x' log="y" log='xy"

y =e* y =e* y =e* y=e*

log=" log= ' log="y" log= xy"

y=x y=x* S y=x

log=" log= ' log="y" log= xy"
y= y =log x =log x y=
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Random Number Generators

Specialized plot commands Functions
Command Description
bar(x,y) Creates a bar chart of y versus x
plotyy(x1l,y1,x2,y2) Produces a plot with two y-axes, yl on

the left and y2 on the right
polar(theta,r,’type’) Produces a polar plot from the polar co-

ordinates theta and r, using the line type,

data marker, and colors specified in the

string type.
stairs(x,y) Produces a stairs plot of y versus x.
stem(x,y) Produces a stem plot of y versus x.

21
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Graphics
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Functions

Wultiple Decay Rates
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Error Bar Plots Fanctions
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Three-Dimensional Line Plots Functions

Plot in 3D the curve: o = ¢~ -0

. —0.05
sin(t),y = e "% cos(t),z =t

| t = 0:pi/50:10%pi; \
| plot3(exp(-0.05%t) .*sin(t), exp(-0.05%t).*cos(t), t) \
‘xlabel(’x’), ylabel(’y’), zlabel(’z’), grid ‘
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Surface Plots S

Surface plot of the function z = e =v")"+"] for —9 < 2 < 2 and
—2 <y < 2 with a spacing of 0.1

‘ [X,Y] = meshgrid(-2:0.1:2); ‘
| Z = X.*exp(-((X-Y."2)."2+Y."2)); \
‘mesh(X,Y,Z), xlabel(’x’), ylabel(’y’), zlabel(’z’) ‘
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Contour Plots Fanctions

Contour plot of the function z = xe*[(“yz)Q*yz], for -2 < 2 <2 and
—2 <y < 2 with a spacing of 0.1

‘ [X,Y] = meshgrid(-2:0.1:2); ‘
| Z = X.*exp(-((X-Y."2)."2+Y."2)); \
‘contour(x,‘{,z), xlabel(’x’), ylabel(’y’) ‘

X 27
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Three-Dimensional Plotting Functions

Function
contour(x,y,z)
mesh(x,y,z)
meshc(x,y,2)

meshz(x,y,z)

surf (x,y,z)
surfc(x,y,z)

[X,Y] = meshgrid(x,y)

[X,Y] = meshgrid(x)
waterfall(x,y,z)

Description

Creates a contour plot.

Creates a 3D mesh surface plot.

Same as mesh but draws contours under
the surface.

Same as mesh but draws vertical refer-
ence lines under the surface.

Creates a shaded 3D mesh surface plot.
Same as surf but draws contours under
the surface.

Creates the matrices X and Y from the
vectors x and y to define a rectangular
grid.

Same as [X,Y]= meshgrid(x,x).
Same as mesh but draws mesh lines in
one direction only.

28
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a) mesh, b) meshc, c) meshz, d) waterfall
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Guidelines for Making Plots

@ Should the experimental setup from the exploratory phase be redesigned to
increase conciseness or accuracy?

@ What parameters should be varied? What variables should be measured?
@ How are parameters chosen that cannot be varied?

@ Can tables be converted into curves, bar charts, scatter plots or any other
useful graphics?

@ Should tables be added in an appendix?

@ Should a 3D-plot be replaced by collections of 2D-curves?
@ Can we reduce the number of curves to be displayed?

@ How many figures are needed?

@ Should the x-axis be transformed to magnify interesting subranges?

30



@ Should the x-axis have a logarithmic scale? If so, do the x-values used
for measuring have the same basis as the tick marks?

o Make sure the each axis is labeled with the name of the quantity being
plotted and its units.

o Make tick marks regularly paced and easy to interpret and interpolate,
eg, 0.2, 0.4, rather than 0.23, 0.46

@ Use the same scale limits and tick spacing on each plot if you need to
compare information on more than one plot.

@ Is the range of x-values adequate?

@ Do we have measurements for the right x-values, i.e., nowhere too dense
or too sparse?

@ Should the y-axis be transformed to make the interesting part of the
data more visible?

@ Should the y-axis have a logarithmic scale?

@ Is it misleading to start the y-range at the smallest measured value?
(if not too much space wasted start from 0)

o Clip the range of y-values to exclude useless parts of curves?



Graphics

Can we use banking to 45°7
Are all curves sufficiently well separated?
Can noise be reduced using more accurate measurements?

Are error bars needed? If so, what should they indicate? Remember that
measurement errors are usually not random variables.

Connect points belonging to the same curve.

Only use splines for connecting points if interpolation is sensible.
Do not connect points belonging to unrelated owners.

Use different point and line styles for different curves.

Use the same styles for corresponding curves in different graphs.

Place labels defining point and line styles in the right order and without
concealing the curves.

32
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Graphics

Captions should make figures self contained.

Give enough information to make experiments reproducible.
Golden ratio rule: make the graph wider than higher [Tufte 1983].
Rule of 7: show at most 7 curves (omit those clearly irrelevant).

Avoid: explaining axes, connecting unrelated points by lines, cryptic
abbreviations, microscopic lettering, pie charts

33
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Outline Functions

2. Random Number Generators
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Random Number Generators

Random Generators
In computers random numbers are generated by pseudo-random generators:

@ sequence of numbers that approximates the properties of random
numbers

@ sequence not truly random, but completely determined by a relatively
small set of initial values, called the PRNG's state, which includes a truly
random seed

Characteristics of good generators:
o long period

@ uniform unbiased distribution
@ uncorrelated (time series analysis)

o efficient

Mersenne Twister is the default algorithm

search “seed” in the Help. Changing random number generator syntax
35
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O utl i n e Functions

3. Functions
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Random Number Generators

User-Defined Functions Functions

function M-file (as opposed to script M-file) defined by syntax:

function [output variables] = name(input variables)

Example
In fun.m
‘ function z = fun(x,y) \ ‘ q = fun(3,7) ‘
|u = 3%x; | |a= \
|z = u+ 6xy.2; \ L 303 J

~ variables have local scope

37



Local Variables

Local Variables do not exist outside the function

Graphics
Random Number Generators
Functions

>>x
>>q
>>x
x =

>>y

=35y =7T;
= fun(x,y);

Undefined function or variable ’u’.

38
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